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Chapter 2

Tutorial

A brief introduction to some of 3D WorldÕs features and tools.
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◆ Launch 3D World

This tutorial uses the Camera, Lights and Renderer Options plug-in palettes and the Cube, 
Point Light, Sphere and Spot Light plug-in geometries. If you have these plug-ins, ensure that 
they are placed in the Plug-ins folder inside the 3D World folder before you launch the applica-
tion.

Open the 3D World folder and double-click on the 3D World application icon. A new, untitled 
document will open, and the Tools palette will be displayed at the left side of the document 
window:

To display the Camera Palette, which allows you to control the camera you are using to view 
the document, select Camera from the Palettes menu:
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The Camera palette will display:

Open the Renderer Options palette by selecting its name from the Palettes menu:

Do not make any changes at this time, unless you are using a 3D accelerator card. If so, make 
sure the Use Hardware checkbox is checked on.

Select Lights from the Palettes menu to display the Lights Palette, which allows you to control 
the lighting in your document. Do not make any changes to the palette at this time:

To open the Info palette, choose Info from the Palettes menu. The Info Palette contains infor-
mation about the currently selected object or group of objects, and allows you to make changes 
to it. Since no object is selected, the options in the Info Palette are grayed out and you cannot 
make any changes:
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You will see the Window toolbar at the bottom of the document window. This palette allows 
you to set characteristics of the view for the current window. Do not make any changes to the 
Window toolbar at this time.
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◆ Changing the Default Color

Click on the Default Color button at the bottom of the Window Toolbar. When the Color Picker 
displays, select a different color by clicking on the color circle:

Click OK. The new Default Color will be shown at the bottom of the Window Toolbar, and will 
be used to draw any new objects.
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◆ Drawing an Object

Go to the Tools Palette and click on the Cubes tool. Move the mouse into the center of the grid, 
click, and drag up and to the right. You will have drawn a solid rectangular box:

◆ Resizing an Object

The box you have just drawn will have red handles at each corner, which you will use to resize 
it. Place the cursor over one of the handles (the arrow will become white). Click and drag to 
make the object taller or wider, depending how you move the mouse. 
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Spot Light
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Hand
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Next, drag one of the handles while holding down the Control key. When you move the mouse 
up and down the screen, the object will get thicker and thinner. Use these controls until you are 
familiar with the action of the Control key:

Resizing can also be done in a controlled way. As you drag an objectÕs handle, hold down the 
Shift key. Four lines, called constrainer lines, will appear on the screen. The red, green and blue 
lines allow you to vary one dimension of the object, while the other two remain constant. The 
pink line allows you to increase or decrease the size of the object while keeping its proportions 
constant. Test the effect of dragging along all lines:
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◆ Moving an Object

Click on the center of the object and drag it around on the screen. Hold down the Control key 
as you drag to move the object closer and further away:

If you hold down the Shift key while moving the object, three constrainer lines will display. 
You can drag the object along these lines to move it along the three axes: 
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You can also use the directional arrow keys on your keyboard to move objects. Select the object 
with the Arrow tool, then press an arrow key to move the object up, down, left or right. If you 
hold an arrow key down, the objectÕs movement will accelerate. To move the object closer and 
further away, hold down the Control key while using the up and down arrow keys.

◆ Rotating an Object

Click on the Rotate tool or type R on the keyboard to select the Rotate tool. When you select 
this tool and click on the object, it will be surrounded by a bounding sphere with handles at the 
points where the bounding lines intersect. As before, when you place the cursor over one of 
these handles, the arrow will change to white. Click and drag to rotate the object:

Hold down the Shift key as you rotate the object to display constraining lines with which the 
object will automatically align. The object will now rotate in 90° steps. Let go of the mouse and 
while continuing to hold down the Shift key, press one of the directional arrow keys. The object 
will rotate now in 45° steps. Releasing the Shift key will allow you to rotate the object in 1° 
steps. If you hold an arrow key down, the rotation will speed up. You can also use the Rotate 
tool to move the object by clicking on it and dragging like you did earlier with the Arrow tool:
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◆ Shadows

You probably noticed that when you dragged the object, a perpendicular line appeared from the 
object to the grid below. The purpose of this line is to let you know where the object is posi-
tioned relative to the grid. 

You may also want to open the Lights Palette and click on the shadows checkbox. Doing so 
will show you a projection of the objectÕs shape on the grid, and help you to gauge the position 
of the object relative to the grid:
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◆ The Info Palette

Select the object and look at the Info Palette. The position of the object and its size will be dis-
played. The default unit of measurement is set at inches or millimeters according to the system 
you are running. Type zero in each of the X,Y and Z Position entry boxes and press Enter. The 
object will move to the center of the grid.

Enter 40 (inches) or 1000 (mm) in each of the Size entry boxes. When you press Enter, the box 
will become a cube. Now enter half the length of the edge of the cube, 20 (inches) or 500 (mm), 
into the Y Position entry box. When you press Enter, the cube will move so that it is resting 
exactly on top of the grid:

Note that you cannot obtain transparency on screen unless you have a QuickDraw 3D accelera-
tor card Þtted in your machine. However, if you apply transparency to an object and subse-
quently transfer the object to a machine with the necessary hardware, the transparency will 
become apparent.
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◆ Add a Sphere

Select the Sphere tool and click on the grid and to the right of the rectangle. Drag the Sphere 
tool up and to the right while holding down the Shift key to constrain the object to a perfect 
sphere. If you want to delete the sphere and draw it again, click on it and press the Delete key, 
or choose Cut from the Edit menu, then start over:

◆ Change the Color of an Object

With the sphere selected, click on the Default Color button at the bottom of the Window Tool-
bar. When the Color Picker displays, select a different color. Click OK and the new color will 
be applied to the sphere and will display on the Default Color button.

If you choose a new color without Þrst selecting an object, you can drag the color onto the 
object later. Click anywhere in the window to deselect the objects, then click on the Color tool 
again. Use the Color Picker to select a new color, then click OK. Hold the mouse down on the 
Color tool, then drag the color onto the rectangular object. The object will be highlighted until 
you release the mouse and update the object with the new color:
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To draw more complex shapes, refer to the information for each plug-in geometry as described 
in Appendix G Ñ Plug-in Geometries on page G-1.
2-13



      
◆ Texture Mapping

Select the Scrapbook from Apple menu items and scroll to the map of the world. Click on the 
map, then drag it to the sphere in your 3D World document. When the sphere is highlighted, 
release the mouse to apply the texture:

See Textures on page D-88 for information about manipulating textures on objects.
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◆ Add Sounds

Go back into the Scrapbook and scroll until you Þnd a sound.

Click on the sound, then drag it onto an object in your 3D World document. Click on the object 
to play the sound. Note that you can drag different sounds onto different objects in the same 
document and play each one. To stop a sound from playing, press (.) key while holding down 
the Command key.

◆ Add 3D Objects

You can also drag 3D objects you have stored in the Scrapbook to a 3D World document. 
Locate a 3D object in the Scrapbook, click on the dotted gray frame around the Scrapbook win-
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dow, and drag the cursor over the 3D World document window. Release the mouse button to 
drop the object into the document. Once placed in the document, you can further manipulate 
the object or change its size. When resizing a 3D object, make sure to hold down the Shift key 
and drag one of its handles along the pink line to retain its proportions:

◆ Librarian

The Librarian application allows you to create an unlimited number of libraries in which you 
can store colors, textures, sounds and 3D objects. These items can also be dragged into your 
documents. Library items may be searched for by name:
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◆ Changing Views

To change your view of objects, you can move the grid, use the Window Toolbar or the Camera 
Palette.

Dragging The Grid

Select the Arrow tool and click and drag anywhere on the grid. You can drag it from side to 
side, up and down: 
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If you hold down the Control key, you can also move the grid towards or away from you:

Rotating The Grid

Select the Rotate tool and hold down the Shift key. Click and drag on the front of the grid. As 
you move the mouse from side to side, the grid will rotate around its center point. If you release 
the Shift key, you can tilt the grid towards or away from you. Take time to experiment with 
these controls until they become familiar:
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Using the Window Toolbar

Click on the black arrow in the Window Toolbar to display the View popup menu:

The popup menu lists your view options, which represent different camera positions. Select a 
several different view options to see how they change your view of objects in the document.

Cameras

Use the controls in the Camera palette to change your view. From left to right, you can Tilt/
Turn; Step/Crab; change the Height; Zoom in and out; and use the Clipping Planes:

To manipulate these camera controls, click on an icon and drag while watching the window to 
see the effect that you are producing. See Camera on page D-30 for more details.

3D World allows you to have more than one window open at a time, with a different view in 
each window. Select New Window from the View menu to display a new window with an iden-
tical view to the original. Use the View popup menu in the Window Toolbar to change the view, 
then drag the new window to one side and resize both windows so you can see them at the 
same time. As you manipulate objects in the Þrst window, you can see how the objects change 
in the second window. When you have Þnished, close the second window.
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◆ Renderer Options

Use the camera popup menu in the Renderer Options palette to change the view from Perspec-
tive to Orthographic. Also try the different renderer options. Click on the checkboxes to see the 
effects they have on the grid, text/sound markers, and the QuickDraw 3D accelerator card (if 
you have one). Return the settings to their default values:

◆ Window Controls

Try the options in the Window toolbar:
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¥ Zoom Out: Use to widen the focus of the cameraÕs view and make objects appear to be far-
ther away.

¥ Zoom In: Use to narrow the focus of the cameraÕs view and make objects appear to be 
closer. 

¥ Wire Frame: Select to view objects in wire frame mode.

¥ Solid Fill: When selected, objects are displayed with Þlled surfaces. 

¥ Orthographic: Select to see an orthogonal view of the document rather than a perspective 
view. In an orthogonal view, all parallel lines display as parallel.

¥ Perspective: Select to see a perspective view of the document rather than an orthogonal 
view. In a perspective view, parallel lines converge. If extended, they would converge at a 
point (the vanishing point).

¥ Coordinate Systems: Select the Camera, World or Object icon to specify a coordinate sys-
tem. The system you choose will affect the way new objects are drawn and existing 
objects are manipulated.

Camera Coordinates: When this option is selected, the X, Y and Z axes relate to the 
direction and angle of the camera.

World Coordinates: When this option is chosen, the X, Y and Z axes relate to the World 
Coordinates and are the same as the grid axes.

Object Coordinates: This is the default option. When the Object Coordinates option is 
chosen, the X, Y and Z axes relate to the orientation of a selected object.

¥ Radius: If selected, objects are drawn from a central point.

¥ Diameter: This is the default mode. When selected, objects are drawn from the point where 
you initially placed the cursor and began to draw.

¥ 2D: If selected, objects can only be drawn in 2D.

¥ 3D: This is the default mode which allows you to draw objects in 3D.

¥ View: Use the View popup menu to select a different view, including any that you have 
saved.

¥ Default Color: The color displayed in the color block at the bottom right of the window 
toolbar is the currently selected color. Any new items created (except lights and markers) 
will automatically be this color, even if you are working in wire frame mode.
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◆ Lighting

In the Lights palette, use the two shorter slider controls to adjust ambient light and sun bright-
ness. Turn these options off and on using the check boxes to the right of the sliders. You can 
also change the color of the light emitted from these sources by dragging a color from the 
Default Color button onto the Color boxes, or by clicking on a color box and selecting a new 
color from the Color Picker:

Point Lights

The slider labeled Spot/Point brightness will affect only the lights that you place in the docu-
ment. To place a light in a document, go to the Tools Palette and click on the Spot Light tool. 
Hold down the mouse button to see the any other tools stacked under the Spot Light tool:

Select the Point Light option, move the cursor back into the document window and click to 
place the light, which will be represented by a light marker and surrounded by a bounding 
sphere. Make sure you have the Best Shading option selected in the Renderer Options Shading 
popup menu. Also make sure the Info Palette is open.

Place the cursor over the light marker and drag it around to see how it affects the shading of the 
objects in the window:
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Use the Info Palette to adjust the brightness of the light. You can also change the color of the 
light by dragging from the Color tool over the Surface box in the Colors section of the Info Pal-
ette, or by dragging the color over the light marker:

Although when selected the light is surrounded by a bounding sphere, rotating point lights 
makes no difference to the lighting effect. If you deselect the light, a small sphere (the light 
marker) will remain in the window to indicate its position.

Spot Lights

Return to the Tools Palette, click on the Point Light tool, hold down the mouse button and 
select the Spot Light tool from the popup menu. Click in the document window to place the 
light:
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Spot lights are directional and can be rotated to shine light in different directions. You can also 
use the controls in the Info Palette to change the characteristics of a spot light, such as its color, 
Brightness, Spread and Sharpness: 

When you have lit the scene how you want, uncheck the Show Lights checkbox in the Lights 
Palette. The light markers will disappear, but their effect will still be apparent.
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◆ Tutorial Stage Set

Close the document you have been working on (you do not need to save it). Choose Open from 
the File menu and open the document ÒTutorial Stage SetÓ that is supplied with 3D World.

There are many different colors in this document, which are produced by shining different col-
ored lights on the set. Use the check box to the right of the Spot/Point Brightness slider in the 
Lights palette to turn off the lights, which causes the scene to go black.

Switch on Ambient light by clicking on the check box to the right of the Ambient Brightness 
slider. You will see that most of the panels are white. Next, turn on Sun light by checking the 
box to the right of the Sun Brightness slider. Notice the difference that sunlight makes to the 
scene. 

Turn off the Sun and Ambient lights and turn on the Spot/Point lights. To see the lights that are 
illuminating the stage set, click on the Show Lights check box at the bottom of the Lights Pal-
ette:
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Choose Preferences from the Edit menu:

Make sure that the Light Marker Color is white (this means that the light markers will display 
with the same color as the light they are emitting). Also make sure that the Sound On check box 
is checked, then click OK. 

Select a light and rotate it to see the difference it makes to the scene. Then, hide the lights again 
by unchecking the Show Lights check box in the Lights Palette.
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Click on one of the drums or cymbals to play the sounds that have been attached.

Select Spin Around Look At from the Options menu to spin the stage:

The right or left arrow keys can be held down to speed up or slow down the spin, and reverse 
its direction. Click anywhere in the window to stop the stage from spinning.

◆ Summary

We hope this tutorial has shown you some of the things that you can do with 3D World. Go 
ahead and try drawing your own scenes. For further explanation of tools and menu items, refer 
to the Reference sections of this manual.
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